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Highlights
We are pleased to introduce several significant enhancements in WellCAD 5.8, designed to elevate your experience  
and streamline your workflows. This update brings a range of new features and improvements:

Fractures rarely occur in isola-
tion. They often form sets and 
networks of interconnected 
fractures that significantly 
influence rock properties like 
strength, porosity, and permea-
bility.  For these properties to be 
affected, fractures must interact 
with each other. 

However, these interactions can-
not be fully explained by fracture 
geometry alone (e.g., length and 
orientation). Instead, analysing 
fracture topology has proven 
to be very effective in describ-
ing relationships such as the 
connectivity between individual 
fractures or fracture sets.

New Fracture Topology Functionality
Inspired by the work of Sanderson, D.J. and 
Nixon, C.W. (2015)*,  WellCAD 5.8 now allows 
for the determination and display of differ-
ent types of nodes indicating the nature of 
fracture connections. These nodes can be 
displayed along with structure picks, provid-
ing a more comprehensive understanding of 
fracture networks (Figure 1):

X-nodes:  
Nodes reflecting intersections of lines  
(i.e., fracture traces).

Y-nodes:  
Nodes from lines terminating at tips.

I-nodes:  
Nodes at isolated ends of a line. Figure 1 - Nodes on fracture connections dividing a  

fracture trace into branches.

Figure 2 - Nodes display on structure picks, node 
distribution and topology descriptors (ATV sample).

• New Fracture Topology Functionality
• Enhanced Header Design
• New Charts

• Improved S-Wave Picking and Empirical Processes
• Depth Matcher Enhancements

Furthermore, the method for picking partial sinusoids 
has been refined to allow for precise adjustment of the 
start and end-points of partial picks in small increments 
after they have been set. This enhancement enables the 
accurate creation of Y- and I-nodes. Additionally, users 
can now customise the shortcut key for partial pick entry 
to better suit their preference.

WellCAD 5.8 introduces the determination and visuali-
sation of distributions and other topology.

The enhanced Structure Interval Statistics process 
(Figure 2) now supports the determination of Pxy statis-
tics, allowing for the calculation of fracture frequencies 
and intensities in one, two, and three dimensions.

* Sanderson, D. J. and Nixon, C. W., (2015). The use of topology in fracture network characterization. 
Journal of Structural Geology, 72, 55-66. https://doi.org/10.1016/j.jsg.2015.01.005



Enhanced Header Design
HeadCAD has been integrated into the WellCAD header editor and 
enhanced with new features. Creating a new header form or editing 
an existing header (attached to a borehole document) can now 
be done directly within the WellCAD application. The functionality 
of the existing header editor (Figure 3) has been improved, and a 
design mode has been added to streamline the process. The stand-
alone HeadCAD application is no longer available in WellCAD 5.8.

As part of the header editor update, several new header objects 
have been introduced. Diagrams from the Polar & Rose log, Chart 
log, Deviation module and Chart tool can now be added and dis-
played (Figure 4). 

Figure 3 - New Header Editor in WellCAD.

Figure 4 - Deviation chart header object.

New Charts
WellCAD 5.8 expands the visualisation 
capabilities with newly added chart 
objects (Pie Charts, enhanced Rose 
diagram display, etc). As a powerful visu-
alisation tool, pie charts are introduced 
as a new diagram type within the Chart 
log functionality and as a Header Chart 
object. They can be used to illustrate the 
percentages of parts and categories in 
relation to a borehole, such as lithology or 
structure type distributions (Figure 5).

Figure 5 - Left-hand side image shows a 
lithology composition pie chart whereas 
the right-hand side image shows a struc-
ture type chart.

Figure 6 - Azimuth, strike 
and dip rose diagrams.

Rose diagrams in Polar & Rose logs, Dip 
workspace and Header forms can now 
display wedges segmented by the pro-
portions of the different structure types 
(Figure 6). The colours of the wedges 
correspond to the specific structure types 
being represented.

These diagrams are dynamically linked to logs in the borehole 
document, ensuring that the display refreshes automatically 
when the data source changes.

Furthermore, hyperlinks can now be added to the header form, 
allowing external media (e.g. URL links) to be accessed directly from 
a borehole document header.



An innovative picking system has been 
added for determining the first arrival 
wave using an algorithm based on kurtosis 
changes in the FWS signal.

Also, in cases where data quality prevents 
clear detection of shear wave intercepts 
and empirical estimations from com-
pressional wave velocities are necessary, 
WellCAD 5.8 introduces various shear wave 
velocity estimation processes including 
methods from Brocher, Castagna, Carroll, 
and Christensen (Figure 7).

Figure 7 - Comparison of all “estimated” 
Vs curves using empirical equations using 
the Vp curve.

Figure 8 - Logplot view showing a depth 
matcher example. Right-hand side image 
shows the new functionality “Undo”, “Redo” 
and “Reset Matching”.

The Match tab has been improved to incorporate three new actions: 
1) Undo, 2) Redo and 3) Reset Matching. These new functions will 
allow users to dynamically and efficiently interact with depth match-
ing operations (Figure 8).

Improved S-Wave Picking and Empirical Processes

Depth Matcher Enhancements



What’s New Feature List

Basic Module

Header Editor

Groundwater

Installer

New Colour Display for  
Picker Dialog Boxes

New colour picker dialog boxes will offer an 
extended range of default colours.

New Colour Gradient Palettes

New default colour gradient palettes will be 
installed with the new version.  

UI Changes

The document protection icon has been 
moved to the bottom of the WellCAD work-
space, next to the time display.

HeadCAD integration within the 
WellCAD Header Editor

The functionality of HeadCAD has been fully 
integrated into the WellCAD Header Editor, 
leading to the discontinuation of the stand-
alone HeadCAD application.

New Header forms workflow

New header forms can now be created 
in WellCAD (File > New). Headers already 
attached to a borehole document can be 
edited in-place using the header editor 
(Tools > Header Editor).

Diagrams and chart Display

Polar & Rose diagrams, cross-plots, pie 
charts, histograms, Schmit plots, devi-
ation diagrams, ternary plots, spinner 
flowmeter calibration charts, CBL charts 
and CBL calibration parameters can now 
be displayed in dedicated header objects, 
which are dynamically linked to logs in the 
borehole document.

New Hyperlink Object

A new hyperlink object (e.g., URLs or links to 
media stored in the cloud) can be added to 
header forms. 

Dynamic Table

A dynamic table object has been introduced 
to present the data from linked logs in a 
spreadsheet format. 

Stacking Pattern Log

Legend objects have been updated to 
accommodate the Stacking Pattern log.

Transmissivity Calculations

A process to compute the transmissivity of 
a formation has been added to the collec-
tion of groundwater processes.

New Units

New units are available for the Hydraulic 
Conductivity process.

Automatic Updates

WellCAD will automatically detect avail-
able updates and prompt the user before 
installation.

Pie Charts

The functionality of the Chart log has 
been extended and pie charts can now 
be displayed for Litho, Strata, Core Desc, 
Structure and other log types.

Updated Histogram View

A new type of histogram view for dip counts 
have been developed.

Polar Projection Enhancement

The Polar plots have been enhanced to allo-
cate more visual and display objects.

Other  
Features



Log Slicing 

The options for the log slicing process have 
been combined into a single dialog box 
improving usability.

Depth Matcher

Three options have been added to aid depth 
match operations. These are “Undo”, “Redo” 
and “Reset Matching”.

Geological Data Export to .LAS Files

Codes and descriptions for geological sym-
bols will be exported into the optional head-
er section of LAS version 3.0 files.

Duplicate logs of the Same Dataset

The display of two sets of the same data-
set/logs are now allowed. An example might 
be the display of Lithology as a background 
colour in a ‘outcrop profile’ and also as a 
separate lithology log.

Other  
Features

Image and Structure Interpretation (ISI) Module

Fracture 
Topology

Structure Interval Statistics

The Structure Interval Statistics process 
has been expanded to include Pxy statis-
tics, enabling the determination of fracture 
frequencies and intensities in one, two, and 
three dimensions.

• Calculation of fracture topology descrip-
tors: Includes the distribution of node and 
branch proportions, line and branch con-
nectivity, and the number of branches to 
the number of lines ratio.

• Pxy statistics to determine fracture fre-
quency and intensity (density) in one, two 
and three dimensions.

Interval Statistics for 
Fracture Spacing

The ability to determine the fracture spac-
ing has been added to the structure interval 
statistics process.

New Display for Rose Diagram

Rose diagram wedges are displayed using 
the colours of the classification attributes. 
The vector diagram displaying dip/azimuth 
and other aspects related to aliasing has 
been also enhanced.

Updated Diagrams

The display for the Woodcock diagram has 
been updated.

Shortcut Key for Partial Picks

The shortcut key for partial picks can now 
be defined by the user.

Structure Log Display

The display of X-, Y- and I-nodes as intro-
duced in fracture topology chapter can be 
enabled in the properties of a structure log 
(when the data is displayed in projection 
mode). Structure logs will show X-, Y- and 
I-nodes when the picks are displayed in pro-
jection mode.

Node and Branch Distribution

Node and branch distribution diagrams have 
been added to the Polar & Rose log, Chart 
objects and for Dips charts.

Partial Picks Setup

The start and end points of a partial pick can 
be fine-tuned by holding down the shortcut 
key (“P”) and dragging them to extend or 
reduce the visible part of the sinusoid.

Aperture Display

The aperture of structural features can now 
be displayed in 3D logs.

Caliper Resolution

The 3D log in the ISI workspace now auto-
matically adjusts the resolution of the 
caliper component to match the one of the 
amplitude components to avoid a blocky 
appearance.

Pipe Deformation Detection

A new ellipse fitting process has been 
added to the Image Module enabling the 
detection and quantification of borehole or 
pipe deformations.

Other  
Features



Breakout Detection

A process to automatically detect breakouts 
from image logs containing radii, caliper of 
travel time data is now available.

Core Cropper Templates

Layout templates for the Core Cropper 
workspace can now be saved and applied. 
This feature is also available in the 
CoreCAD module.

Core Cropper “rotate left”

A button “rotate left” has been added to 
improve usability.

Radius to/from Diameter Process

The Radius to / from Diameter process is 
no longer exclusive to the Casing Integrity 
Module and is now available in the ISI 
Module > Image Log menu as well.

Metada Bar Icons

Header icons are added to substitute light-
bulb icons when dealing with metadata 
display types.

View Angle Value Updates

The view angle value is updated on the title 
while rotating the log.

Full Waveform Sonic (FWS) Module

Automation Module

Picking

Functions

Methods

New Picking System

A new first arrival picking algorithm based 
on kurtosis changes of the FWS signal has 
been added.

New Empirical Shear Wave  
Velocity Methods 

Shear wave velocities can now be estimat-
ed using popular empirical compressional 
waves relationships introduced by Brocher, 
Carroll, Castagna and Christensen.

New and Updated  
Automation Functions

New and updated automation functions are 
available supporting the following process-
es in WellCAD:

• Creation of linked logs (log cloning).

• Structure interval statistics has been 
updated to support fracture topology.

• Shear wave velocity estimation.

• Transmissivity determination.

• Automatic breakout picking.

Other  
Features



Bug Fixes

v5.7 fixes Fracture Height Calculation Process

The fracture height calculation process now 
takes partial picks correctly into account.

Partial Picks

Partial picks keep their feature depth after 
the apparent to true correction.

Snap Grid Sensitivity

Switching the units of the ruler bar to quan-
tities different from the default defined in 
Tools > Options > Document Layout is now 
handled correctly.

WellCAD Links

Some links included in the Help Files are now 
fixed and content can be accessed.

Depth Shift Functions

Depth shifting operations are allowed for all 
type of integers. 

TFD Imports in Automation

The automation function now correctly 
imports all channels based on the specified 
configuration file.


